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RULE 1: INTRODUCTION 
The CFA Institute Research Challenge is a competition between university-sponsored Teams that research a 

designated publicly traded company, prepare a Written Report on that selected company and then present 

their findings to a panel of Judges. The competition has three levels: Local, Regional, and Global. Winners at 

the Local level advance to compete against Teams within their geographic region at the Regional level. 

Winning Teams at the Regional level advance to compete at the Global level. One Team is designated the 

ultimate winning Team, or Champion, at the Global level. 

RULE 2: TEAMS 

2.1 Team Composition  

Up to two (2) Teams may represent a University.1 Local Hosts have the sole discretion to allow more than one 

(1) team. When a Local Host agrees to allow two (2) teams, both teams must participate in the same local final.     

a) Each University Team may consist of both undergraduate and graduate students.  

b) A Team must consist of no fewer than three (3)2 and no more than five (5) members; and 

c) There can be no alternates. If a Team loses one of its members, that member can be replaced no later 

than two (2) weeks prior to the submission of the Written Report at the Local level. If a Team falls below 

three (3) registered members after this date, they will not be eligible to continue in the competition. 

2.2 Team Member Requirements 

Each Team Member must: 

a) accept the terms of the Participation Agreement upon registration; 

b) agree to abide by the CFA Institute Code of Ethics and Standards of Professional Conduct; 

c) be a currently enrolled college or university student in an undergraduate or graduate program at the 

time of the Local level Kickoff Meeting;3 

d) be registered for at least a part-time course load, as defined by his or her University, at the time of the 

Local level Kickoff Meeting; and 

                                                           
1
 A University is defined as a degree-granting institution that primarily delivers teaching to students in a traditional educational setting 

such as a classroom, as opposed to solely through electronic media. This includes universities that provide online learning in addition to 

their classroom-based course offerings. The institution should hold educational accreditation by an accrediting agency recognized by 

mainstream academia to operate as an accreditor or authorization by a government organization, whichever is the standard for the 

country where the institution is located. CFA Institute may, at its sole discretion, grant exceptions to this rule on a case-by-case basis. 

2
 If, due to extenuating circumstances, such as travel visa denial or serious illness/injury, less than three (3) members of a team are 

able to attend one of the in-person events (local, regional, or global), that team will not be disqualified provided that there are still at 
least three (3) official members on the team. If a team member is formally dismissed from or voluntarily quits the team, and the 
remaining team comprises less than three (3) members, that team will no longer be eligible to participate in the competition.  
 
3
 If the Team Member has graduated at the time of the Local, Regional or Global final, the Team member may still participate in the 

competition. 

 

http://www.cfainstitute.org/ethics/codes/ethics/Pages/index.aspx
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e) complete the official registration form on the CFA Institute Research Challenge website no later than 

two (2) weeks prior to the submission of the Written Report to the Local level Host. Timely completion 

of the official registration entitles students to be recognized participants by CFA Institute. 

2.3 Ineligibility 

An individual is ineligible to be a Team Member, if that individual: 

a) has previously participated as a Team Member at any level of the CFA Institute Research Challenge  

on any team that has submitted a Written Report at the Local level; 

b) has been, or is, employed in a role whose primary duty involves fundamental company analysis at the 

time of the Local level Kickoff Meeting;4 unless the Team member qualifies as an intern5, and is 

permitted to participate as a Team Member, under Local competition rules. 

c) has been, or is, a CFA charterholder; or  

d) has been sanctioned by the CFA Institute Professional Conduct Program.  

2.4 Research 

Only Team Members may conduct research on the Subject Company for the purposes of the CFA Institute 

Research Challenge. Teams may use only publicly available information6 in conducting their research.  

a) Teams may utilize their Industry Mentor and/or Faculty Adviser as resources, but may not enlist the 

help of any other professionals in conducting research specific to the Subject Company.  

b) The Written Reports and Presentations should be prepared from the perspective of an independent 

research analyst.  

c) Teams can read existing research on the Subject Company, but all analysis should be their own; they 

may not copy analysis (i.e., plagiarize) from another source into their Written Reports or Presentations.7 

Sourced information should be properly cited using a generally accepted citation system.8  

                                                           
4 Fundamental company analysis is defined as the examination of publicly available information and the formulation of forecasts to 

estimate the intrinsic value of an equity security. Examples include estimating an equity security’s value using company data, such as 
earnings and sales forecasts, and risk estimates as well as industry and economic data, such as economic growth, inflation, and 
interest rates. 
 
5
 CFA Institute defines an internship as real-world work experiences in which students fulfill short-term positions within a company  

or organization in order to gain hands-on experience and develop career-specific skills. Internships may be paid or un-paid, with or  
without academic credit, and are of varying lengths. 

 
6
 Publicly available information includes: 

1) Information in company financial statements, press releases, and  
2) Information in the media about the company and its competitors 
3) Information from data aggregators (e.g., Bloomberg, CapIQ, FactSet, etc.) 

 
Publicly available information does not include: 

1) Information about the company that is (or should be) known only to staff or some staff employed by the company or firms with 
whom the company does business. 

2) Information that is (or should be) known only to those involved in legal or regulatory proceedings involved with the company. 
 

7
 Volunteer charterholders who mentor or advise students must request and receive permission from their firm to share reports 

prepared either within their firm or from outside sources. Additionally, all volunteers who work with students should ensure that they 
understand how to avoid plagiarism and what is required when citing the work of another research analyst.  
 



 
 

5 
 

d) Teams may not have contact with Subject Company corporate executives for the purposes of the CFA 

Institute Research Challenge other than during the below-described informational session and the one 

permitted follow-up communication.  

The Subject Company may provide Teams with an informational session. The informational session may 

include a question and answer session during which time Teams may pose questions to the Subject Company 

and the Subject Company may respond. Teams may send one follow-up communication to the Subject 

Company. When contacting the Subject Company, each Team must confine its contact to those corporate 

officers who normally interact with investors, such as IR officers, CEO’s or CFO’s. Teams may not contact 

Subject Company corporate executives for the purposes of the CFA Institute Research Challenge other than 

the informational session, the question-and-answer session, and the one permitted follow-up communication. 

Teams are permitted to interact with the company as a member of the general public (e.g. teams may dine in a 

restaurant that is a subject company or take a tour or the subject company if it is generally available). 

Teams may contact the Subject Company’s customers, competitors, former employees, and suppliers in 

conducting research, including surveys; however, each Team Member must identify him/herself as a student 

and disclose his/her participation in the CFA Institute Research Challenge. 

Prior to contacting the Subject Company, its customers, competitors, former employees, or suppliers, the 

Team must submit its questions to the Faculty Adviser or Industry Mentor. The Faculty Adviser or Industry 

Mentor must participate in each contact but only for the purpose of ensuring that no material non-public 

information is discussed. Faculty Advisers and Industry Mentors are not permitted to ask any questions or 

provide any opinions on the Subject Company. The Faculty Adviser or Industry Mentor time while monitoring 

this kind of contact will not count towards the maximum number of hours allotted for Faculty Adviser or Industry 

Mentor involvement. 

2.5 Written Reports 

Each Team must prepare a written research report on the Subject Company. Teams may utilize their Industry 

Mentor or Faculty Adviser as resources, but may not enlist the help of any other professionals in writing the 

actual report.  

The Written Report must: 

a) conform to the guidelines set forth in Appendix A, “Written Report Guidelines;” the cover pages are 

shown in  Appendix B; 

b) not exceed 10 A4-sized pages9, but may include an appendix of infinite length; 

c) contain only publicly available information; 

d) be the original work of the Team Members; 

e) be prepared from the perspective of an independent research analyst; and  

f) be submitted to the Local level host by the deadline established by the Host.10  

                                                                                                                                                                                                                        
8
 Generally accepted citation systems include, but are not limited to, The Chicago Manual of Style, the Harvard referencing system, and 

the MLA Style.  
9
 Instructions on how to change the paper size in Microsoft Word are available in Appendix C.  

10
 Hosts may impose penalties for late submissions. Penalties may include, but are not limited to, point deductions or disqualification 

from the competition. The decision to impose penalties and the extent of those penalties is at the discretion of the host. 
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The Written Report will be graded according to the criteria set forth in Appendix D, the Research Report 

Evaluation Form. 

2.6 Presentations 

Each Team may make a Presentation of its findings to a panel of Judges. 

a) Teams may utilize their Industry Mentor and/or Faculty Adviser as resources, but may not enlist the 

help of any other professionals in preparing content or evaluating the Presentation, including 

conducting practice presentations in front of one or more professionals (e.g., mock judging panels). 

Teams may utilize presentation coaches or other public speaking resources as long as those resources 

do not contribute to the content of the presentation.  

b) The students may not hand the Judges any printed materials before/after the Presentations but the 

Local Host should print out the Presentation slides for each Team and distribute to the Judges before 

the event. 

c) Teams may not use props11 in their Presentation. 

d) Only Team Members may participate in the Presentation.  

e) The Presentation is limited to ten (10) minutes; however, an additional ten (10) minutes will be provided 

to answer questions posed by the Judges. Only Judges are permitted to pose questions to a Team 

during the question-and-answer portion of a Presentation. 

f) Each Presentation will be timed and the Timekeeper will provide a one (1) minute warning and an 

announcement when time has expired. When the Timekeeper announces that time has expired, Teams 

must immediately conclude the Presentation. 

g) Presentations will be judged according to Appendix E, the Presentation Scoring Sheet. 

RULE 3: FACULTY ADVISERS, INDUSTRY MENTORS, JUDGES AND GRADERS 

3.1 Faculty Advisers 

a) Each Team will be provided one (1) Faculty Adviser. The Faculty Adviser must be currently employed 

as a faculty member by the Team’s sponsoring University. 

b) The Faculty Adviser will be selected by the Team’s University.  

c) The Faculty Adviser’s primary responsibility is to provide guidance and direction to the Team 

throughout all levels of competition.  

d) The Faculty Adviser may not contribute any research or content to either the Written Report or 

Presentation.  

3.2 Time Permitted with Faculty Advisers 

Teams are only permitted to use a Faculty Adviser on substantive matters for a total of ten (10) hours. 

Logistical work such as arranging meeting space and times and class attendance does not count toward the 

ten (10) hour limit. This ten (10) hour limit with the Faculty Adviser must occur prior to submitting the Written 

Report. For each Local, Regional, or Global Final in which the Team competes, the Faculty Adviser may 

contribute an additional 3 hours. 

                                                           
11

 A prop is defined as an object used by students to enhance or illustrate an aspect of the team presentation. 
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3.3 Industry Mentors 

Each Team will be provided one (1) Industry Mentor.  

a) The Industry Mentor will be selected by the Local level Host. 

b) The Industry Mentor may review the Team’s written report, but may only provide comments.  

c) The Industry Mentor may not contribute any research or content to either the Written Report or 

Presentation.  

d) Students may not receive assistance from additional finance industry professionals.  

e) It is recommended that Industry Mentors be CFA charterholders. 

3.4 Time Permitted with Industry Mentors 

Teams are only permitted to use an Industry Mentor on substantive matters for a total of six (6) hours. 

Logistical work such as arranging meeting space and times does not count toward the six (6) hour limit. The 

meetings with the Industry Mentor must occur prior to submitting the Written Report. For each Local, Regional, 

or Global final in which the Team competes, the Industry Mentor may contribute an additional two (2) hours. 

3.5 Judges and Graders 

Judges 

a) Judges will evaluate each Presentation using the Presentation Scoring Sheet attached as Appendix E.  

b) Each Local level competition must have a minimum of three (3) Judges per panel.  

c) The Judges will be selected by the event Host. All Judges must be investment professionals with 

experience in writing and reviewing research reports.  

d) It is recommended that Judges be CFA charterholders. 

 

Graders 

a) Graders will evaluate each Written Report using the Research Report Evaluation Form attached as 

Appendix D. 

b) Graders will be selected by the event Host.  

c) All Graders must be investment professionals with experience in writing and reviewing research 

reports.  

d) It is recommended that Graders be CFA charterholders. 

RULE 4: LOCAL LEVEL COMPETITION 

4.1 Eligibility of Host 

Only CFA Institute, CFA Institute Member Societies, and CFA Institute approved entities are eligible to serve 

as Local level Hosts. 

4.2 Competition Requirements 

Local level competitions must have at least three (3) Universities, as defined in Rule 2.1, committed to 

participating by the specified competition start date. If fewer than three (3) Universities commit to participating 

by the competition start date in a Local level competition, the winning Team in that Local final will not be 

eligible to compete at the Regional level. If Universities drop out of the competition after the competition start 
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date, the winning Team in that Local final will be eligible to compete at the Regional level even if there are 

fewer than three (3) Universities at the end of the local competition.  

 

Universities participating at the Local level must be physically located within the natural geographic region of 

that university’s Local host.12  

 

The Winner from each eligible Local level competition (as defined above) will advance to a Regional level 

competition. If the Local level competition has at least 24 Universities competing, then the top two (2) 

Universities will advance to a Regional level competition. Only the first place finisher in local-level competitions 

involving 23 participating universities or less will advance to the Regional competition.  

 

Local level competitions must adhere to one of the following competition formats: 

a) Classic Format. Each Team submits a Written Report and gives a Presentation to a panel of Judges. 

The winning Team will have the highest combined score based on the Written Report results (50%) and 

the Presentation results (50%). 

b) Staggered Format. Each Team submits and is evaluated on a Written Report. The Teams (at least 3) 

with the highest Written Report scores13 advance to give a Presentation to a panel of Judges. If all 

teams are evaluated by the same Graders, then those scores may travel with the teams to the 

presentation rounds and the winning Team will have the highest combined score based on the Written 

Report results (50%) and the Presentation results (50%). If the Teams are evaluated by different sets of 

Graders, the winning Team will be the team with the highest Presentation results. 

c) District Format. Teams are assigned to one of at least four (4) districts. There must be at least four (4) 

teams in each district. Each Team submits a Written Report and gives a Presentation to the district’s 

panel of Judges. Each district will send the Team with the highest score in that district to the Local 

Final. The winning district Teams will compete against one another at the Local Final to determine the 

winning Team. 

 

In the event of a tie between Presentation scores at the Local Final, the winner will be determined in the 

following order: 

a) The Team receiving the higher overall score for the Presentation will advance.  

                                                           
12

 Societies may submit requests for an exception to this rule; these requests will be evaluated by CFA Institute. 

 
13

 In the event of a tie between Written Reports at a local competition (staggered format only), the Local Host should determine 
which report had the higher score in the following sections, ranked by order of importance. The team with the higher scores, as 
ranked below, will advance to the Local Final. 
1. Financial Analysis 
2. Valuation 
3. Investment Summary 
4. Industry Overview and Competitive Positioning 
5. Investment Risks 
6. Business Description 
7. Other Headings 
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b) If there is still a tie between the overall score for the Presentation, the Team receiving the higher score 

in the Financial, Valuation, and Other Analysis section of the Presentation would be deemed the 

winner.  

c) If there is still a tie between the overall score for the Presentation and the Financial, Valuation, and 

Other Analysis section, the Team receiving the higher score in the Questions section of the 

Presentation would be deemed the winner.  

d) If there is still a tie between the overall score for the Presentation; the Financial, Valuation, and Other 

Analysis section; and the Questions section of the Presentation, the Team receiving the higher score in 

the Argument section will be deemed the winner.  

e) If there is still a tie between the overall score for the Presentation; the Financial, Valuation, and Other 

Analysis section; the Questions section; and the Argument section of the Presentation, the Team 

receiving the higher score in the Team Involvement section will be deemed the winner. 

4.3 Host Requirements 

Local level Hosts must: 

a) sign and submit the CFA Institute Research Challenge Host Agreement by 14 August 2015; 

b) select the Subject Company in accordance with the following rules: 

i. The Subject Company must be publicly traded, 

ii. The Subject Company can only work with one local competition (no local level research 

challenge competitions may share the same Subject Company), and 

iii. The Subject Company must be in the host's natural geographic area unless otherwise approved 

by CFA Institute. 

c) select the Industry Mentors, Graders, and Judges; 

d) ensure that all Team Members meet the eligibility requirements set forth in Section 2.2; 

e) ensure that no Team Members are ineligible pursuant to Section 2.3; and 

f) send the result of the Local level and the winning Team’s Written Report to CFA Institute within two (2) 

days of completion of the Local Final. 

4.4 Travel and Accommodations 

Participants and volunteers are responsible for any and all expenses incurred for travel and accommodations 

related to the local level competition unless otherwise specified by the Local Host.  

RULE 5: REGIONAL LEVEL COMPETITION 

5.1 Regional Level Host 

CFA Institute will act as the host for the Asia Pacific; Europe, Middle East, and Africa; and Americas Regional 

level competitions. 
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5.2 Travel and Accommodations 

a) CFA Institute will cover travel and accommodation costs for the Winning Team of each eligible Local 

level competition (as defined in Rule 4) and one sponsored guest. 14 The sponsored guest will be 

determined by the Winning Team. 

b) All students and sponsored guests must book their travel to and from the event using the official CFA 

Institute travel management company.15 Reservations made through agencies other than the official 

travel management company will not be eligible for reimbursement.  

c) CFA Institute will cover round-trip economy airfare. CFA Institute only covers the lowest cost round trip 

option that takes travelers from their departure city to the competition location and back. If travelers 

decide to extend their stay, choose different layovers, etc. CFA Institute will only pay for lowest cost 

round trip option. Extra costs will be incurred by the traveler. 

d) All travelers must book travel by the deadline specified by CFA Institute. If travelers book later than this 

date, CFA Institute will only cover the cost the flight would have been by the deadline. Extra costs will 

be incurred by the traveler.  

e) CFA Institute will not pay for taxis, rental cars, visa application fees, food and beverage (not provided at 

a CFA Institute-sponsored function), baggage fees, and any other fees and expense not specifically 

approved above. 

f) All travel arrangements for which CFA Institute will pay must be made through a CFA Institute approved 

travel agency and payment will be remitted directly to the agency, not to any participant. 

g) CFA Institute will arrange hotel rooms for the winning Team of each eligible Local level competition (as 

defined in Rule 4) and one sponsored guest. 

h) Students will room with one other student. Roommates will be assigned by CFA Institute according to 

university affiliation and gender. Students may be assigned to room with a student from another 

university. 

i) Students may make alternative flight and lodging arrangements at their own expense.  

5.3 Competition and Scoring 

The winning Team from each Regional competition will advance to the Global Final. If the Regional level 

competition has at least 40 Universities competing, then the top two (2) Universities will advance to a Global 

level competition.   

 

Teams must submit their Presentations in the specified version of Microsoft PowerPoint. CFA Institute will 

announce the supported version of Microsoft PowerPoint in advance of each Regional competition. CFA 

Institute cannot guarantee technical support for Presentations submitted in any other format.  

 

During the first round of each Regional competition (quarterfinal or semifinal round), the overall score will be 

based on 50% Written Report score and 50% Presentation score. CFA Institute will send the Written Report 

from each Team to a group of Regional Graders. These Graders will score reports for the Teams competing 

                                                           
14

 Limited to a Faculty Adviser, Industry Mentor, or CFA Institute Research Challenge Host representative 
15

 Travel and Transport in the Americas Region; CT Corporate Travel in the Europe, Middle East, and Africa Region; and Swire in the 
Asia Pacific Region.  
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against each other in that first round (i.e., the reports for each Team in Room 1 will be scored by one group of 

Graders, the reports for each Team in Room 2 will be scored by another group of Graders, and so on).  

 

The overall score for each subsequent round of competition will be based 100% on the Presentation as set 

forth by Rule 2.6. Regional Judges will assess the Presentation score using Appendix E.  

RULE 6: GLOBAL LEVEL COMPETITION 

6.1 Global Level Host 

CFA Institute will act as the host for the Global Final. 

6.2 Travel and Accommodations 

a) CFA Institute will cover travel and accommodation costs for the Winning Team of each eligible Regional 

level competition (as defined in Rule 4) and one sponsored guest.16  The sponsored guest will be 

determined by the Winning Team.  CFA Institute will accommodate the Winning Team from the 

Regional competition hosted in conjunction with the Global Final by extending the hotel stays for the 

duration of the event and re-booking return travel, if needed, for that Team and its sponsored guest. 

b) All students and sponsored guests must book their travel to and from the event using the official CFA 

Institute travel management company.17 Reservations made through agencies other than the official 

travel management company will not be eligible for reimbursement. 

c) CFA Institute will cover round-trip economy airfare. CFA Institute only covers the lowest cost round trip 

option that takes travelers from their departure city to the competition location and back. If travelers 

decide to extend their stay, choose different layovers, etc. CFA Institute will only pay for lowest cost 

round trip option. Extra costs will be incurred by the traveler. 

d) All travelers must book travel by the deadline specified by CFA Institute. If travelers book later than this 

date, CFA Institute will only cover the cost the flight would have been by the deadline. Extra costs will 

be incurred by the traveler.  

e) CFA Institute will not pay for taxis, rental cars, visa application fees, food and beverage (not provided at 

a CFA Institute-sponsored function), baggage fees, and any other fees and expense not specifically 

approved above. 

f) All travel arrangements for which CFA Institute will pay must be made through a CFA Institute approved 

travel agency and payment will be remitted directly to the agency, not to any participant. 

g) CFA Institute will arrange hotel rooms for the Winning Team of each eligible Regional level competition 

(as defined in Rule 4) and one sponsored guest. 

h) Students will room with one other student. Roommates will be assigned by CFA Institute according to 

university affiliation and gender. Students may be assigned to room with a student from another 

university. 

i) Students may make alternative flight and lodging arrangements at their own expense.  

                                                           
16

 Limited to a Faculty Adviser, Industry Mentor, or CFA Institute Research Challenge Host representative 
17

 Travel and Transport in the Americas Region; CT Corporate Travel in the Europe, Middle East, and Africa Region; and Swire in the 
Asia Pacific Region.  
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6.3 Competition and Scoring 

The Winning Teams from each Regional competition, including Asia Pacific; Europe, Middle East, and Africa; 

Americas will compete in the Global Final.  

 

Teams must submit their Presentations in the specified version of Microsoft PowerPoint. CFA Institute will 

announce the supported version of Microsoft PowerPoint in advance of the Global competition. CFA Institute 

cannot guarantee technical support for Presentations submitted in any other format.  

 

The overall score will be based 100% on the Presentation as set forth by Rule 2.6. Global Final Judges will 

assess the Presentation score using Appendix E.  

RULE 7: GENERAL PROVISIONS 

7.1 Use of Reports 

CFA Institute shall own the copyright in all materials prepared by or for Hosts, Teams, Industry Mentors, 

Graders, Judges, or Faculty Advisers in connection with the CFA Institute Research Challenge. The Written 

Reports and Presentations prepared for the Challenge may not be used for any purpose other than 

participation in the CFA Institute Research Challenge. 

7.2 Conflicts of Interest 

All participants in the CFA Institute Research Challenge, including Hosts, Teams, Team Members, Mentors, 

Faculty Advisers, Judges and Graders have an obligation to avoid actual or potential conflicts of interest with 

their participation. A conflict of interest may exist when a participant or a participant’s family member or close 

friend is involved in activities that may impact the participant’s ability to perform their role fairly and impartially. 

Hosts, Mentors, and Advisers also have an obligation to avoid purposefully or inadvertently pressuring Teams 

to make a particular investment recommendation. A conflict may be actual or perceived. To avoid any actual or 

perceived conflicts of interest, each participant must disclose to CFA Institute in writing any potential conflicts, 

including but not limited to any ownership interest in the Subject Company and any close personal or 

professional relationships with employees at the Subject Company. 

 

Judges and Graders must further disclose any close personal or professional relationship with Team Members, 

Mentors or Faculty Advisers. 
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Appendix A – Written Report Guidelines 
 
Each team must prepare a written research report on the subject company chosen by the local host. Teams may utilize 
their industry mentor or faculty Adviser as resources, but may not enlist the help of any other professionals in writing the 
actual report.  
 
The Written Report must: 

 be no longer than ten (10) pages (not including the front and back covers provided by CFA Institute) on A4* sized 
paper (210mm × 297mm, 8.27” × 11.69”), although you may include an appendix of infinite length; 

 include the following information in a header on the first page: 
o Company name 
o Exchange 
o Ticker symbol 
o Sector 
o Industry 
o Recommendation (buy/sell/hold) 
o Current price (as of __date) 
o Target price (% increase/decrease) 

 contain only publicly available information; 

 be the original work of the team members; 

 be prepared from the perspective of an independent research analyst;  

 be submitted to the local-level host by the deadline established by the host;  

 include the front and back covers provided by CFA Institute with the information in highlighted text filled in (teams 
must not alter any other part of the cover pages, including the CFA Institute logo); the back cover should be 
placed after the appendix; and 

 contain (but is not limited to**) the following sections: 
o Business Description  
o Industry Overview and Competitive Positioning  
o Investment Summary 
o Valuation 
o Financial Analysis 
o Investment Risks 

 
*If you would like to print an A4 sized document to Letter sized paper, you can selected the option to automatically resize 
the document in your printing options by selecting Page Layout > Page Setup > Print Options > Advanced and making 
sure “Scale content for A4 or 8.5 x 11” paper sizes” is selected: 

**You may also include other headings that cover important information not otherwise covered in the sections listed 
above.  
 
The reports will be graded based on the scoring rubric in Appendix D. Take note of the comments section, which presents 
reasons why points may be deducted from each section.  
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Appendix B – Written Report Cover Pages 
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Disclosures: 
Ownership and material conflicts of interest: 

The author(s), or a member of their household, of this report [holds/does not hold] a financial interest in the securities of this company. 

The author(s), or a member of their household, of this report [knows/does not know] of the existence of any conflicts of interest that might bias 

the content or publication of this report. [The conflict of interest is…] 

Receipt of compensation: 

Compensation of the author(s) of this report is not based on investment banking revenue. 

Position as a officer or director: 

The author(s), or a member of their household, does not serve as an officer, director or advisory board member of the subject company. 

Market making: 

The author(s) does not act as a market maker in the subject company’s securities. 

Disclaimer: 

The information set forth herein has been obtained or derived from sources generally available to the public and believed by the author(s) to be 

reliable, but the author(s) does not make any representation or warranty, express or implied, as to its accuracy or completeness. The information 

is not intended to be used as the basis of any investment decisions by any person or entity. This information does not constitute investment 

advice, nor is it an offer or a solicitation of an offer to buy or sell any security. This report should not be considered to be a recommendation by 

any individual affiliated with [Society Name], CFA Institute or the CFA Institute Research Challenge with regard to this company’s stock. 
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Appendix C – How to Change Paper Size to A4 
 

For Microsoft Word 2007/2010: 

 Open Microsoft Word. 

 Click on the “Page Layout” ribbon. 

 Click “Size.” 

 Scroll until you find “A4.” 

 Select A4. 

 Watch a step-by-step video here.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Microsoft Word 2003: 

 On the File menu, click Page Setup, and then click the Paper tab. 

 Select A4. 

 See the Microsoft website for more information.

http://www.youtube.com/watch?v=ySXNA1ki1x0
http://office.microsoft.com/en-us/word-help/select-paper-size-HP005189493.aspx
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Appendix D – Research Report Evaluation Form 
 

 
 

    www.cfainstitute.org/researchchallenge  

 

Research Report Evaluation Form 

   

Section 
Maximum 

Points Comments 

      

Business Description 5  

Industry Overview  & 
Competitive Positioning 15  

Investment Summary 20  

Valuation 20  

Financial Analysis 20  

Other Headings 5  

Investment Risks 15  

Total 100   
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Appendix E – Presentation Scoring Sheet 

 
    www.cfainstitute.org/researchchallenge 
 

CFA Institute Research Challenge 

Presentation Scoring Sheet 

 

Team:  Judge:  

 

 

Criteria 
 

Maximum 
Points 

 

Points 
 

Notes 

Argument 
Did they use data 
effectively to support their 
recommendation? 

 

25   
 

Questions 
Were they able to answer 
questions effectively? 

25 
 
 

 

Financial, Valuation, and 
Other Analysis 

Were the financial 
analysis, valuation models, 
and sensitivity analysis 
rigorous and appropriate? 
 

20 

 

 

 

 

Team Involvement 
Team involvement in the 
presentation/Questions 
and Answers 

 

15 

 

 

 

 

Poise 
Were they confident? 
Were they convincing? 

10 

 

 

 

Materials 
Quality of slides 

5 

  

Total 100 
  

 


